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Creating your first
Windows Phone application
Now that you have the necessary background on the Windows Phone platform and
the Windows Phone Developer Tools, it’s time to get down to business and start pro-
gramming. You’ll start by building a Hello World project. For developers experi-
enced with Visual Studio, simple Hello World projects may seem unduly remedial.
But Windows Phone projects have several unique settings and features that you need
to understand to build applications and games. The Hello World project in this
chapter is designed to highlight these aspects of Windows Phone development. 

 In addition to the controls shipped as part of the Windows Phone SDK, we’ll
look at a few of the controls that are available in the Windows Phone Toolkit. The
Windows Phone Toolkit is an open source project hosted on CodePlex. Microsoft
uses the Windows Phone Toolkit project to share new controls and components
with the development community.

This chapter covers
■ Creating your first application
■ Handling touch events
■ Navigating between pages
■ Pinning secondary tiles
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 You’ll build a Hello World application and explore a few of the phone-specific
extensions to XAML. XAML applications have several project properties unique to
Windows Phone. Two of these properties define the icons used in the phone’s Start
Screen and Applications List. Other properties determine the titles shown next to the
Start and Application List icons. You’ll learn how to use the Visual Studio project tem-
plates to generate a new application and how to use the item templates to generate a
new page for your application. You’ll also learn how to deploy the application to the
emulator or a physical device and use the debugger to step through code.

TIP If you’re new to XAML development, read the primer on XAML in
appendix A.

In most ways, building a XAML application for the phone is the same as building a
Silverlight application for the browser, a WPF application for the desktop, or a XAML
application for the Windows 8 Runtime, but there are some minor differences. You’ll
see some of the differences as you build your application. The Hello World applica-
tion that you’ll create is shown in figure 2.1.

 The application displays a title, draws a globe, and prompts the user to enter a name.
When the user taps the text box’s action icon, the application navigates to a greeting
page. You’ll start building your application by creating a new Silverlight project. 

Figure 2.1 The Windows Phone 8 in Action Hello World application. The 
screen on the left is shown when the application starts, and the screen on the 
right is shown when the user taps the text box’s action icon.
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2.1 Generating the project
To start the Hello World application, you use the Windows Phone App project tem-
plate in Visual Studio. The Windows Phone App project template is one of several
project templates installed with Visual Studio. Table 2.1 lists the available project tem-
plates.

 Open Visual Studio and create a new project by choosing File > New Project. Fig-
ure 2.2 shows the New Project dialog for the Hello World application. Select the Win-
dows Phone App project template and name the project HelloWorld.

After you click OK, you’re prompted with a dialog asking you to pick the target operat-
ing system version. This dialog can be confusing because it lists the Windows Phone
SDK versions and not the operating system versions. If you’re building an application
that targets older devices running the Windows Phone 7.5 operating system, choose
Windows Phone OS 7.1 from the drop-down. After you click OK, a new Visual Studio
solution and project are created. The IDE opens MainPage.xaml in the editor, and
you’re ready to begin.

Table 2.1 Windows Phone project templates*

Project template Description

Windows Phone App A basic application skeleton with a single page.

Windows Phone Databound App An application demonstrating page navigation, databound list con-
trols, and the MVVM pattern.

Windows Phone Class Library A simple library for creating reusable components.

Windows Phone Panorama App An application demonstrating a databound Panorama control and 
the MVVM pattern. The Panorama control is covered in chapter 14. 

Windows Phone Pivot App An application demonstrating a databound Pivot control and the 
MVVM pattern. The Pivot control is covered in chapter 14.

Windows Phone XAML and 
Direct3D  App

An application that mixes managed XAML with native Direct3D 
graphics. The Direct3D portion of the application is written in C++.

Windows Phone HTML5 App An application that uses the WebBrowser control to display a user 
interface written in HTML and JavaScript. HTML5 Apps are covered 
in chapter 17.

Windows Phone Audio Playback 
Agent

A library containing an application’s background audio logic. Audio 
Playback Agents are covered in chapter 9.

Windows Phone Audio Streaming 
Agent

A library containing an application’s background streaming audio 
logic.

Windows Phone Scheduled Task 
Agent

A library containing an application’s background processing logic. 
Scheduled Tasks Agents are covered in chapter 4.

* Each of the project templates listed here is available for both C# and Visual Basic projects.
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Before you start work, let’s take a look at what Visual
Studio created. Figure 2.3 shows the new project in
the Solution Explorer. 

 The project structure mirrors that of a regular
.NET Framework project with Properties and Refer-
ences folders, App.xaml, MainPage.xaml, App-
Manifest.xml, and AssemblyInfo.cs. Along with the
references to the .NET and Windows Phone assem-
blies, a few additional files are present: 

■ WMAppManifest.xml
■ ApplicationIcon.png
■ FlipCycleTile*.png
■ IconicTile*.png
■ LocalizedStrings.cs
■ AppResources.resx

 

Figure 2.3 Project files and
folders in the Solution Explorer

Figure 2.2 Visual Studio’s New Project dialog box shows the available C# Windows Phone project 
templates.
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The PNG image files are used by the operating system when displaying the application
in the Start Screen, Application List, or Games Hub. We’ll look at the image files in
more depth later in the chapter.

WMAPPMANIFEST.XML AND THE WINDOWS PHONE STORE

WMAppMainfest.xml contains metadata for the application, providing important
details about the application to the operating system. Information in WMApp-
Manifest.xml is also used by the Windows Store to validate and list an application.
Visual Studio adds the WMAppManifest file to the XAP file deployment package when
it builds an application. The final WMAppManifest.xml file that appears in the pack-
age downloaded to a user’s phone won’t necessarily contain the same information the
developer specified when they built the application before submitting it to the Win-
dows Store. During Windows Store certification, the application is examined, and its
manifest file is updated. A product identifier is added, the hub type or genre is set,
and the security capabilities are confirmed. 

 Many of the settings in WMAppManifest.xml are set via the project property pages.
Open the WMAppManifest.xml file and look for the App element, specifically the
Genre attribute:

<App xmlns="" ProductID="{10408c51-ec5c-43b6-b196-3f11505591cd}" 
    Title="HelloWorld" RuntimeType="Silverlight" 
    Version="1.0.0.0" Genre="apps.normal" 
    Author="HelloWorld author" Description="Sample Description"
    Publisher="HelloWorld"
    PublisherID="{022cce02-8389-4f02-b74b-48f6b7544d37}">

The Genre attribute declares whether the application appears in the Application List
or the Games Hub.

 Your new Hello World project is ready to be built and deployed to the emulator or a
phone. Visual Studio’s Debugger is used to debug running Windows Phone applications.

2.1.1 Debugging phone projects

Once you’ve built a project, you’ll be able to debug it both in the emulator and on a
real device. Before starting a debug session, you’ll want to confirm that the appropri-
ate target is selected in the Target Deploy-
ment Device combo box. In figure 2.4, you
can see that Emulator WVGA 512MB is the
target device, and the application will be
launched in the emulator.

Figure 2.4 The Target Deployment Device selector
showing the default deployment target (Emulator

WVGA 512MB), the list of all the emulators,
and a connected Windows Phone device

Genre can be 
Apps.Normal 
or Apps.Games



35Generating the project
The first time you launch an application in the emulator, it takes some time to boot
and initialize the emulator prior to starting the application. Once the application has
been launched, you’ll be able to debug and interact with it in the emulator. You can
keep the Windows Phone emulator running between debugging sessions.

TIP An application can detect whether it’s running in the emulator by
checking the value of the Microsoft.Devices.Environment.DeviceType
static property. If the value is DeviceType.Emulator, the application is run-
ning in the emulator.

Prior to launching an application on a real device, the phone must be plugged in to
the USB port and connected to your computer. And before you can deploy and debug
an application on a real phone, you must register your phone with the Developer Reg-
istration tool. The Developer Registration tool is introduced in chapter 1. 

SOURCE CODE BREAKPOINTS AND DEBUGGING

When the application is being debugged, it automatically stops on the breakpoints
you’ve set in the source code. You can add or remove breakpoints during the execu-
tion as you would in any other desktop or Silverlight project. The debugger remains
attached to the emulator even when your application isn’t running. This feature lets
you debug scenarios such as launching from a secondary tile, which you’ll learn how
to do later in the chapter. When you’re finished, you can stop debugging in the IDE.

 Visual Studio allows you to install or deploy the project on the device without start-
ing a debugging session. Right-click the project name in the Solution Explorer and
select Deploy from the menu. The application will be copied to the target device or
emulator and can be launched from the Applications List on the phone. When the
application is launched, Windows Phone adds a few custom steps to the startup pro-
cess that aren’t found in Silverlight or WPF applications. 

2.1.2 Application startup

Like any other Silverlight or WPF application, the entry point is a System.Windows
.Application-derived class found in App.xaml. All phone applications are XAML nav-
igation applications. In your phone application, the App class creates an instance of
PhoneApplicationFrame, which is used as the RootVisual. Behind the scenes, the
application host calls the NavigationService directly to navigate to MainPage.xaml
during initial launch. When an application is reactivated, the application host navi-
gates to the active page’s XAML—see chapter 3 for more details on application launch-
ing and activation. 

RENAMING MAINPAGE.XAML

All this magic navigation is well and good; the application starts, and MainPage is auto-
matically loaded. What happens when you decide to rename MainPage.xaml? Because
the XAML filename doesn’t have to match the name of the C# class that it contains,
changing the name of MainPage is a two-step process. Fortunately, Visual Studio’s refac-
toring features make this a simple operation. In the Solution Explorer, right-click
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MainPage.xaml, choose Rename, and change the filename to HelloPage.xaml. Renam-
ing MainPage.xaml will also cause MainPage.xaml.cs to be renamed to HelloPage
.xaml.cs. Open HelloPage.xaml.cs, select the MainPage text in the class definition, and
choose Rename from the Refactor menu, specifying HelloPage as the new name.

 When you debug the application now, the App.RootFrame_NavigationFailed
event handler is called. Figure 2.5 shows the NavigationFailedEventArgs properties
sent to the event handler.

 Even though you renamed MainPage.xaml, the application is still configured to
use MainPage.xaml as the startup URI. The startup URI is declared in the WMApp-
Manifest.xml file as the NavigationPage attribute of the Task named _default. As
with a number of other WMAppManifest.xml settings, you can set the Navigation page
using the project property editor or by editing the default task URI in the XML file.
Open WMAppManifest.xml, update the URI attribute, and then save and run the
application:

<Tasks>
  <DefaultTask  Name="_default" 
    NavigationPage="HelloPage.xaml"/>
</Tasks>

In this section you created a new Windows Phone application project and examined
the files created by the project template. You learned that a PhoneApplicationFrame
is the root visual for the application and that the operating system uses the navigation
framework to load the Startup page. Now that the application is running and you’ve
customized the name of the Startup page, you’ll customize the page contents.

2.2 Implementing Hello World
The project template created a default main page for your application, which you
renamed to HelloPage.xaml. In this section you’ll add a second page to the applica-
tion that will display a greeting message. The second page will employ a pair of Text-
Block controls as well as a RichTextBox. You’re also going to customize HelloPage by
drawing a globe and asking the user to input their name.

 First, we’ll take a closer look at the page created for you by the project template.

2.2.1 Customizing the Startup page

The Windows Phone App project template created the Startup page with several ele-
ments meant to match the page design to the Microsoft design language described in

Figure 2.5 NavigationFailedEventArgs properties after renaming MainPage.xaml
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Microsoft’s Design Library for Windows Phone. The design library, found in the Windows
Phone Dev Center at http://dev.windowsphone.com/en-us/design/library, details
the expected look and feel of phone applications. The following listing shows the
XAML markup added by the project template for HelloPage’s content.

<Grid x:Name="LayoutRoot"                       
      Background="Transparent">                
    <Grid.RowDefinitions>                       
        <RowDefinition Height="Auto" />        
        <RowDefinition Height="*" />           
    </Grid.RowDefinitions>                      
    <!--TitlePanel contains the name of the application and page title-->
    <StackPanel x:Name="TitlePanel"               
                Grid.Row="0"                      
                Margin="12,17,0,28">              
        <TextBlock x:Name="ApplicationTitle"
                   Text="MY APPLICATION"
                   Style="{StaticResource PhoneTextNormalStyle}" />
        <TextBlock x:Name="PageTitle"
                   Text="page name"
                   Margin="9,-7,0,0"
                   Style="{StaticResource PhoneTextTitle1Style}" />
    </StackPanel>
    <!--ContentPanel - place additional content here-->
    <Grid x:Name="ContentPanel"            
          Grid.Row="1"                            
          Margin=”12,0,12,0”>                     
    </Grid>
</Grid>

The page’s root layout panel is a Grid control that has been split into two rows B. The
first row contains TitlePanel c, which stacks two TextBlock controls for the applica-
tion and page titles. The remainder of the page is allocated to the ContentPanel d.
Figure 2.6 shows HelloPage.xaml as created by the project template. 

Listing 2.1  HelloPage’s content as created by the project template

LayoutRoot Grid 
control with two rows

b

TitlePanel with 
two TextBlocksc

ContentPanel for 
all other markup

d

Figure 2.6 HelloPage.xaml’s TitlePanel in the Visual Studio Designer
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BEST PRACTICES FOR APPLICATION AND PAGE TITLES

Application and page titles aren’t required by the design guidelines or store certifica-
tion, but you should follow several rules when using them. The application title should
be the name of the application and should be in all uppercase characters. The page title
should be in all lowercase characters and should describe the data or features displayed
on the page. The titles shouldn’t scroll or wrap; when the title doesn’t fit on the screen,
the text should appear truncated. If the title panel appears on the main page, it should
appear on all pages to provide the user with a consistent experience.

 In HelloPage.xaml, update the application title to WINDOWS PHONE 8 IN ACTION
and the page title to hello world: 

<TextBlock x:Name="ApplicationTitle"
                   Text="WINDOWS PHONE 8 IN ACTION"
                   Style="{StaticResource PhoneTextNormalStyle/>
<TextBlock x:Name="PageTitle"
                   Text="hello world"
                   Margin="9,-7,0,0"
                   Style="{StaticResource PhoneTextTitle1Style}" />

The title TextBlock controls have their Style properties set to a static resource. The
style resources used here aren’t found anywhere in your project—they’re styles
injected into your application by the XAML framework so that your application can
adhere to the user interface theme chosen by the user. Theme resources are also used
in the root PhoneApplicationPage element to set the font and foreground color
properties for the page:

FontFamily="{StaticResource PhoneFontFamilyNormal}"
FontSize="{StaticResource PhoneFontSizeNormal}"
Foreground="{StaticResource PhoneForegroundBrush}"

ORIENTATION PROPERTIES

PhoneApplicationPage also has a couple of orientation properties: Orientation and
SupportedOrientations. The Orientation property specifies whether the current
orientation is portrait or landscape. The SupportedOrientations property declares
which orientations are supported by the page. The visual designer supports both por-
trait and landscape and allows you to quickly switch between the two layouts, as shown
in figure 2.7. 

 Windows Phone presents a status bar at the top edge of the screen in portrait lay-
out. In landscape layout, the status bar is anchored to the edge opposite the Start but-
ton as it moves to the left or right, depending on the direction in which the user
rotates the phone. The status bar displays the signal strength, battery, current time,
and other indicators. Screen designs should account for the space occupied by the sta-
tus bar, which varies depending on the screen resolution of the device. Applications
can hide the status bar with the SystemTray.IsVisible attached property. The proj-
ect template sets this attached property to True. You can provide more room for your
application’s content and hide the status bar by setting the property’s value to False. 
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NOTE Before you choose to hide the status bar in your application, you
should know that many users consider the status bar an essential element and
dislike applications that hide it. 

You’re making good progress. You’ve gotten your hands dirty with XAML and started
customizing your application. Along the way, you’ve learned how to ensure your appli-
cation fits into the system look and feel. Your next step is to add a globe and text box
to the application content panel.

2.2.2 Adding application content

Remember that you want the first page of the application to display a globe and
prompt the user to enter a name. These visual elements will be added to the Content-
Panel Grid control that was created by the project template, as shown in the next list-
ing. You’ll start by dividing the ContentPanel into two rows, with one row using two-
thirds of the panel, and the second using the remaining third.

<Grid x:Name="ContentPanel" Grid.Row="1" Margin="12,0,12,0">
    <Grid.Resources>
        <SolidColorBrush x:Key="GlobeBrush"               
             Color="{StaticResource PhoneAccentColor}" /> 
    </Grid.Resources>
    <Grid.RowDefinitions>
        <RowDefinition Height="2*" />
        <RowDefinition Height="1*" />
    </Grid.RowDefinitions>
    <Canvas Width="200" Height="200" VerticalAlignment="Center"
        Background="{StaticResource PhoneBackgroundBrush}" > 
        <Ellipse Width="200" Height="200"
            Stroke="{StaticResource GlobeBrush }"
            StrokeThickness="10" />

Listing 2.2 Drawing the globe

Figure 2.7 Use the device panel to switch between portrait and landscape layouts. The device 
panel also provides controls for changing the theme, accent color, and device resolution.

GlobeBrush is 
static resourceb

Binding to 
theme brushc
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        <Ellipse Width="100" Height="200" 
            Canvas.Left="50"
            Stroke="{StaticResource GlobeBrush }"
            StrokeThickness="5" />
        <Path Data="M 100,0 100,200"
            Stroke="{StaticResource GlobeBrush }"            
            StrokeThickness="5" />
        <Path Data="M 0,100 200,100"
            Stroke="{StaticResource GlobeBrush }"
            StrokeThickness="5" />
        <Path Data="M 30,40 A 100,50 0 0 0 170,40"
            Stroke="{StaticResource GlobeBrush }"
            StrokeThickness="5" />
        <Path Data="M 30,160 A 100,50 0 0 1 170,160"
            Stroke="{StaticResource GlobeBrush }"
            StrokeThickness="5" />
    </Canvas>
</Grid>

The globe is drawn using Silverlight’s Ellipse and Path drawing primitives. These are
two examples of the drawing primitive classes found in the System.Windows.Shapes
namespace. The sphere of the globe and the two arced meridians are drawn with
ellipses. The straight meridian and the three parallels are drawn with paths. The draw-
ing canvas is centered in the first row of the ContentPanel. 

TIP To improve an application’s performance, Microsoft recommends that
complex XAML graphics be captured in a PNG or JPG and displayed with an
Image control. 

Each of the shapes has its Stroke property bound d to a static resource you create
named GlobeBrush B. GlobeBrush has its Color property bound to another static
resource named PhoneAccentColor. The canvas has its Background bound to a static
resource named PhoneBackgroundBrush c. PhoneBackgroundBrush and Phone-
AccentBrush are other examples of the system theme resources that the Windows
Phone injects into a XAML application. The Visual Studio System Resource picker,
shown in figure 2.8, is accessed from the System Resource option in a property’s
Advanced Options menu.

 In this section, you added XAML markup to draw a globe and bind the globe ele-
ments to system brushes to enable theme support. You still need to add UI controls to
implement the remaining requirement, which is to navigate to the Greeting page and
display the user’s name. First, you need to create the Greeting page. 

2.2.3 Adding the Greeting page

The second page of your application will display a greeting to the user, using the
name typed into the main page. Add the new page by selecting Project > Add New
Item and then choosing the Windows Phone Portrait Page item template. Name the file
GreetingPage.xaml. The Portrait Page item template is one of several item templates

Binding to 
GlobeBrushd
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that ship with the Windows Phone Developer Tools. Table 2.2 lists the Windows Phone
page item templates.

The new Greeting page contains controls for the application and page title. Following
the same steps described for the Hello page, change the application title to WINDOWS
PHONE 8 IN ACTION and the page title to greetings.

Table 2.2 Windows Phone page item templates

Page template Description

Windows Phone Portrait Page A basic application page with title and description fields. The 
Orientation and SupportedOrientations properties are set to 
Portrait.

Windows Phone Landscape 
Page 

An application page identical to a Portrait page, except that the 
Orientation and SupportedOrientations properties are set to 
Landscape.

Windows Phone User Control A starting point for creating reusable XAML-based controls.

Windows Phone Panorama 
Page 

Adds an application page with the Panorama control as its only content 
element. 

Windows Phone Pivot Page Adds an application page with the Pivot control as its only content 
element.

Figure 2.8 Visual Studio’s System Resource menu shown when clicking the Advanced option 
button that appears on the right edge of most properties in the property editor. The first item in the 
menu is the name of the property, which in this screen shot is Background.
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 The Greeting page uses a couple of TextBlocks and a RichTextBox control to dis-
play the message. The XAML markup for the page’s content panel is shown in the fol-
lowing listing.

<Grid x:Name="ContentPanel"
      Grid.Row="1"
      Margin="12,0,12,0">
    <Grid.RowDefinitions>
        <RowDefinition Height="72" />
        <RowDefinition Height="100" />
        <RowDefinition Height="*" />
    </Grid.RowDefinitions>
    <TextBlock Margin="{StaticResource PhoneMargin}"  
        Text="Hello" Style="{StaticResource PhoneTextLargeStyle}" />
    <TextBlock x:Name="helloMessage" Grid.Row="1"                
        Margin="{StaticResource PhoneMargin}" Text="name goes here"
        Style="{StaticResource PhoneTextExtraLargeStyle}" />
    <RichTextBox Grid.Row="2" Margin="{StaticResource PhoneMargin}"  
        VerticalAlignment="Top">
        <Paragraph FontSize="{StaticResource PhoneFontSizeNormal}">
            Welcome to</Paragraph>
        <Paragraph FontSize="{StaticResource PhoneFontSizeMedium}" 
            Foreground="{StaticResource PhoneAccentBrush}" >
            <Italic>Windows Phone 8 in Action</Italic>
        </Paragraph>
        <Paragraph FontSize="{StaticResource PhoneFontSizeNormal}">
            Written by Timothy Binkley-Jones, Adam Benoit, 
            Michael Sync, and Massimo Perga.</Paragraph>
    </RichTextBox>
</Grid>

Start by dividing the content panel into three rows, specifying fixed heights for the
first two rows. In the first row place a TextBlock containing the text “Hello.” Use the
PhoneMargin resource B to align the controls with the TextBlocks in the title panel.
Add a second TextBlock and give it the name helloMessage c. You’ll use this Text-
Block to display the name of the user. Add a RichTextBox d, which you’ll use to dis-
play formatted text. On Windows Phone, the RichTextBox is read-only. 

SYSTEM THEME RESOURCES IN THE GREETINGPAGE

What’s interesting in listing 2.3 is the use of system theme resources. Using the theme
style gives you compatibility with the user experience guidelines and is a good starting
point to keep consistency between your application and the rest of the Windows
Phone ecosystem. The available theme text styles are as follows:

■ PhoneTextAccentStyle  
■ PhoneTextContrastStyle 
■ PhoneTextExtraLargeStyle 
■ PhoneTextGroupHeaderStyle 
■ PhoneTextHugeStyle 

Listing 2.3 GreetingPage’s content

Using PhoneMarginb
extBlock
or user’s

name

c

ead-only
hTextBox d
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■ PhoneTextLargeStyle 
■ PhoneTextNormalStyle 
■ PhoneTextSmallStyle 
■ PhoneTextSubtleStyle 
■ PhoneTextTitle1Style 
■ PhoneTextTitle2Style 
■ PhoneTextTitle3Style 

When you use the theme text styles, you’re assured that your text will match the
theme colors chosen by the user. Three different title styles, a group header style, and
five different-sized text styles are defined. There are also styles defined for subtle,
accent, and contrast text. Figure 2.9 displays the text styles in both the dark and light
themes.

 The PhoneTextContrastStyle’s color matches the theme’s background, and text
drawn with it won’t be visible unless the background has been changed. In figure 2.9,
the contrast text is placed inside a Border control whose background is drawn with
the PhoneContrastBackgroundBrush.

 You now have the two pages in your Hello World application set up and ready to
go. If you run the application now, you’ll see the Hello page with the nice globe. But
other than look at the globe, you can’t do anything in the application yet. You still
need to add input controls to capture the user’s name. You also need something the
user can use to navigate to the Greeting page. Let’s take a look at how you interact
with the user.

Figure 2.9 Theme text styles shown in the dark and light themes 
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2.3 Interacting with the user
XAML for Windows Phone provides most of the core user input controls that are avail-
able to Silverlight for the browser. The input controls have been modified and
restyled to work in a touch-only environment and have new events that are raised
when the user touches the screen. To maintain compatibility with Silverlight for the
browser, the Windows Phone controls also provide mouse-related events and automat-
ically promote touch events into mouse events. Unless you’re specifically looking for
touch events, you work with the input controls in nearly the exact same way you do
when building browser applications.

 There will be situations where you want to work with the touch events and ges-
tures. Raw touch events are decomposed into start, delta, and stop events. Touch gestures
combine several raw touch events into well-known gestures such as Tap, Double Tap,
Hold, Pinch, Pan, and Flick. In this section you’ll learn how to capture Tap and Dou-
ble Tap gestures to change the color of the globe. First, let’s take a closer look at how
a text box operates on Windows Phone.

2.3.1 Touch typing

The Hello World application uses a PhoneTextBox control for text entry. The Phone-
TextBox control is part of an external library that isn’t included in the Windows
Phone SDK, called the Windows Phone Toolkit. The toolkit is available for free from
CodePlex (http://phone.codeplex.com) and can be added to your project with the
NuGet Package Manager. You can also download a zip file that includes the full source
code along with a sample application.

USING THE WINDOWS PHONE TOOLKIT

The Windows Phone Toolkit is packaged in a single assembly called Micro-
soft.Phone.Controls.Toolkit.dll. You need to add a reference to this assembly before

Figure 2.10 Add a reference to the Windows Phone Toolkit with the Manage NuGet Packages dialog.
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using any of the toolkit’s components. To add a reference to a NuGet package such as
the Windows Phone Toolkit, click Project > Manage NuGet Packages. When the Man-
age NuGet Packages dialog appears, type Window Phone Toolkit in the Search Online
input control and press Enter. A list of matching packages is shown in figure 2.10.
Select the toolkit package from the list and click Install.

 When working with toolkit components in XAML, you need to include an XML
namespace declaration at the top of your page: 

xmlns:toolkit="clr-namespace:Microsoft.Phone.Controls;

➥ assembly=Microsoft.Phone.Controls.Toolkit"

Now you’re ready to add the PhoneTextBox to the ContentPanel of HelloPage.xaml.
Because you’ll need to reference the PhoneTextBox from code when you display the
greeting message, give it the name nameInput:

<toolkit:PhoneTextBox Grid.Row="1" x:Name="nameInput" 
   VerticalAlignment="Top" InputScope="Text" 
   Hint="Enter your first name" ActionIcon="/Assets/next.png" />

The PhoneTextBox extends the
normal TextBox control with a
Hint and an ActionIcon, as shown
in figure 2.11. The Hint is a water-
mark that displays when the field is
empty. The ActionIcon represents
a button that can be clicked to exe-
cute some code. You’ll wire up the
ActionIcon to an ActionIcon-

Tapped event handler later in the
chapter. The next.png file is one of
the icons that comes from the Windows Phone SDK, which are installed to C:\Program
Files\Microsoft SDKs\Windows Phone\v8.0\Icons. On 64-bit Windows, the SDK is
installed in C:\Program Files (x86). Right-click the Add the Assets folder in the Solu-
tion Explorer and select Existing Item from the Add menu. Navigate to the SDK Icons
folder and pick the next.png file from the Light folder. Make sure the Build Action is
set to Content. 

 When the user touches inside the PhoneTextBox, the onscreen keyboard is dis-
played if the device doesn’t have a physical keyboard. The InputScope property can
be used to control which software input panel is displayed to the user.

CONTROLLING THE KEYBOARD WITH INPUT SCOPE

Windows Phone devices have been designed to be fully touch-enabled, and a physical
keyboard isn’t present on many models. When a TextBox has the focus on a device
that doesn’t have a physical keyboard in use, a virtual keyboard or software input
panel (SIP) is displayed. By default, the TextBox invokes a SIP with the standard
QWERTY keyboard layout and doesn’t provide text correction or suggestions. A num-
ber of different keyboard layouts are available, each one tailored to a specific task.

Hint

Action icon

Figure 2.11 The PhoneTextBox from the Windows 
Phone Toolkit. The PhoneTextBox extends a normal 
TextBox with a hint watermark and an action icon. 
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Input scope names are defined by the InputScopeNameValue enumeration. Table 2.3
lists a few of the input scope names that are useful to Windows Phone applications.

Table 2.3 is only a partial list of input scopes. For a full list, see the MSDN documenta-
tion for the InputScopeNameValue enumeration at http://mng.bz/p9zM.

 When developing your application, you should choose the most appropriate key-
board layout for your TextBox controls. If your TextBox accepts standard text phrases,
you should consider using one of the layouts that provide suggestions and/or auto-
matic correction. If your application automatically performs work or navigation once
the user has input some text, you might want to use one of the layouts that provide a
customized Enter key, which suggests some action will occur when Enter is pressed. If
you have an input field that accepts only numbers, you might consider using the Num-
ber input scope. More than 60 different values are defined in the InputScope-
NameValue enumeration. See the MSDN documentation for the full list and how each
one affects the TextBox. We recommend that you always specify an InputScope, even
if you only use the Text input scope that you’ve used here. The Text input scope pro-
vides word-correction features that aren’t available with the default input scope.

 The onscreen keyboard also exposes clipboard copy-and-paste operations. TextBox
automatically supports the clipboard, and your application doesn’t need to do any-
thing special to enable clipboard operations. Developers can programmatically copy
text to the system clipboard to share with other applications. Before we show how to
copy text to the clipboard, let’s look at how touch gestures are supported. Your appli-
cation can listen for Tap gestures and perform custom actions in response to gesture
events. 

Table 2.3 Common input scopes

Input scope name Description

Chat A QWERTY keyboard layout with text suggestions and an emoticons key. 
Automatic correction isn’t enabled.

EmailNameOrAddress
EmailSmtpAddress

A QWERTY keyboard with @ and .com keys. Text suggestions and 
automatic correction aren’t enabled. 

Maps A QWERTY keyboard layout with text suggestions and a customized Enter 
key. Automatic correction isn’t enabled.

NameOrPhoneNumber A QWERTY keyboard layout with a semicolon key and access to the 12-key 
number pad. Text suggestions and automatic correction aren’t enabled.

TelephoneNumber 12-key number pad with * and #.

Search A QWERTY keyboard layout with a customized Enter key. Text suggestions 
and automatic correction aren’t enabled.

Text A QWERTY keyboard layout with text suggestions and automatic correction 
enabled.

Url A QWERTY keyboard layout with a .com key and a customized Enter key. 
Text suggestions and automatic correction aren’t enabled.
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2.3.2 Touch gestures

The Windows Phone defines the touch gestures Tap, Double Tap, Hold, Pan, Pinch,
and Flick. The Windows Phone SDK exposes three gesture events:

■ Tap 
■ DoubleTap 
■ Hold 

To demonstrate how touch gestures can be used in an application, you’ll change the
color of the globe when it’s tapped by the user. Changing the color of the globe can
be accomplished by changing the color of the brush used to draw the globe’s ellipse
and path graphics. Remember that you bound all the graphic elements to the static
resource named GlobeBrush. To access the brush resource from code, you need to
define a field and then initialize the field with the SolidColorBrush that’s stored in
the ContentPanel’s resource dictionary:

using System.Windows.Media;
...
SolidColorBrush globeBrush;
public HelloPage()
{
    InitializeComponent();
    globeBrush = (SolidColorBrush)ContentPanel.Resources["GlobeBrush"];
}

Before you implement the Tap and DoubleTap event handlers, you need to add a cou-
ple of fields to enable color changes. The first is an array of colors, and the second is
an index of the current color: 

Color[] colors = new Color[] { Colors.Red, Colors.Orange, 
    Colors.Yellow, Colors.Green, Colors.Blue, Colors.Purple };
int colorIndex = 0;

ENABLING TAP AND DOUBLETAP EVENTS

Hook up the Tap and DoubleTap events to the canvas panel containing the globe:

<Canvas Width="200" Height="200" VerticalAlignment="Center"
    Background="{StaticResource PhoneBackgroundBrush}"
    Tap="Canvas_Tap" DoubleTap="Canvas_DoubleTap">

In the Tap event handler, you want to assign the globeBrush’s Color property to the
next color in the colors array. Don’t forget to check the index and reset it to the
beginning of the array:

private void Canvas_Tap(object sender, 
    System.Windows.Input.GestureEventArgs e)
{
    colorIndex++;
    if (colorIndex >= colors.Length)
        colorIndex = 0;
    globeBrush.Color = colors[colorIndex];
}
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In the DoubleTap event handler, you reset the brush color to the accent color provided
by the system theme. The accent color can be obtained from the application resources:

private void Canvas_DoubleTap(object sender, 
    System.Windows.Input.GestureEventArgs e)
{
    globeBrush.Color = (Color)App.Current.Resources["PhoneAccentColor"];
}

If your application requires gestures beyond Tap and Hold, you’ll need to process the
raw manipulation events raised by the XAML controls. The UIElement class exposes
ManipulationStarted, ManipulationDelta, and ManipulationCompleted events
when a user touches, moves, and releases their finger from the screen. Converting
manipulation events into gestures is beyond the scope of this book.

 Now that you’ve learned about gestures, let’s discuss how to copy text to the system
clipboard. Your application will copy text to the clipboard when a toolbar button is
pressed. 

2.3.3 Adding a toolbar button

Windows Phone provides a built-in toolbar and menu control called the application
bar. For your Hello World application, you need to add an application bar with three
buttons to GreetingPage.xaml. The three buttons are labeled ok, copy, pin:

<phone:PhoneApplicationPage ... >
    <phone:PhoneApplicationPage.ApplicationBar>
        <shell:ApplicationBar >
            <shell:ApplicationBarIconButton Text="ok"
                IconUri="/Assets/AppBar/check.png" />
            <shell:ApplicationBarIconButton Text="copy"
                IconUri="/Assets/AppBar/save.png" />
            <shell:ApplicationBarIconButton Text="pin"
                IconUri="/Assets/AppBar/share.png" />
        </shell:ApplicationBar>
  </phone:PhoneApplicationPage.ApplicationBar>

The application bar markup is added as a child element of the PhoneApplication-
Page element. In the application bar, you’re using a few more of the icons from the
Windows Phone SDK, which are installed to C:\Program Files\Microsoft SDKs\Windows
Phone\v8.0\Icons\Dark. Create a project folder called AppBar within the folder called
Assets and add the check.png, save.png, and share.png files to the folder. For each of
the images, set the Build Action to Content. You’ll read more about the application
bar in chapter 13.

 Like any other buttons, ApplicationBarIconButtons raise a Click event when the
user taps them. You’ll register for the Click event on the copy button and implement
the event handler. Update the button’s markup to declare the event handler:

<shell:ApplicationBarIconButton Text="copy"
    IconUri="/Assets/AppBar/save.png"
    Click="copyButton_Click" />



49Page navigation
Add the event handler in GreetingPage.xaml.cs:

private void copyButton_Click(object sender, EventArgs e)
{
    string message = string.Format("Hello {0}!", helloMessage.Text);
    Clipboard.SetText(message);  
}

The event handler constructs a message by concatenating the word Hello and the text
in the helloMessage TextBlock. The greeting message is then copied to the Clip-
board and is ready to be pasted into some other application.

In this section you learned how to receive typed text from the user, respond to touch
gestures, and use the system application bar to display a toolbar button. You imple-
mented a click handler for one of the toolbar buttons, but the other two buttons don’t
perform any work. The unimplemented buttons will be used to navigate between the
two pages, which we cover in the next section.

2.4 Page navigation
A phone application is a modified version of a XAML navigation application. XAML
navigation applications are composed of a navigation frame and one or more pages
that interact with the NavigationService. The NavigationService interacts with the
operating system to maintain a journal or history of pages visited by the user. In this
section you’ll add navigation to the Hello World application.

The Model-View-ViewModel pattern

Many, but not all, XAML developers use the Model-View-ViewModel pattern (MVVM)
to separate user interface markup and logic from application logic. The separation of
UI and application logic promoted by MVVM is made possible with XAML’s data binding,
value converter, and commanding features. Input and TextBlock controls are bound
to model objects, which often implement the INotifyPropertyChanged interface.
Values are converted to strings using converter classes that implement IValueCon-
verter. Click event handlers are eschewed in favor of command objects implementing
the ICommand interface.

Though MVVM separates UI and business logic, it introduces complexity. We’ve in-
tentionally avoided using the complexity of the MVVM pattern in the sample applica-
tions in the book. We’ve also avoided binding trivial properties, such as messages
displayed in a TextBlock, and have placed a great deal of our application logic in the
page code-behind. MVVM is a great pattern that’s well suited for XAML applications,
but one criticism of MVVM is that it’s overkill for simple applications.

This is a book about Windows Phone, not XAML, but we’ve included an appendix where
you can learn more about MVVM. The bits of XAML we use in the sample applications
are intended to highlight the features of the Windows Phone SDK. 
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2.4.1 Navigating to another page

Page navigation is the process that takes the user from one page to another. One
example occurs when the user taps a button to open a new page and then, after com-
pleting some work, taps another button to come back to the main page. Navigation is
managed by the NavigationService class. The NavigationService.Navigate

method is called to move to a new page. When Navigate is called, the current page is
placed on the navigation stack, and a new instance of the target page is generated.
The NavigationService.GoBack method removes the current page and restores the
previous page that’s on the navigation stack.

ADDING PAGE NAVIGATION TO HELLO WORLD

You’ll now add page navigation to your Hello World application. Starting in Hel-
loPage.xaml, add an ActionItemTapped event handler to the PhoneTextBox: 

<toolkit:PhoneTextBox Grid.Row="1" x:Name="nameInput" 
   VerticalAlignment="Top" InputScope="Text" 
   Hint="Enter your first name" ActionIcon="/Assets/next.png" 
   ActionIconTapped="nameInput_ActionIconTapped" />

You want to navigate to GreetingPage when the icon is pressed, so you need to add
code to the event handler:

void nameInput_ActionIconTapped(object sender, RoutedEventArgs e)
{
    this.NavigationService.Navigate(
        new Uri("/GreetingPage.xaml", UriKind.Relative));
}

You access the NavigationService via the PhoneApplicationPage’s Navigation-
Service property. The Navigate method accepts a Uri, which in this case is the name
of the file containing the page you want to load. You construct the Uri using Uri-
Kind.Relative because it’s part of the same XAP file.

 Reopen GreetingPage.xaml and generate the click event handler for the OK appli-
cation bar button:

<shell:ApplicationBarIconButton Text="ok"
    IconUri="/Assets/AppBar/check.png" 
    Click="navigateBackButton_Click" />

You implement the handler by calling the GoBack method:

void navigateBackButton_Click(object sender, EventArgs e)
{
    this.NavigationService.GoBack();
}

Now press F5, or choose Debug > Start Debugging, and debug the application. You’ve
linked your two pages using only two lines of code. Press the action icon and see the
second page appear. When you press the OK button, the main page appears again.

 It’s worth noting that you use the GoBack method instead of the Navigate method
to return to MainPage.xaml. When you call GoBack, the current page is removed from
the page stack. If you’d used Navigate, a new page would’ve been added on top of the
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page stack. Depending on the scenario you want to achieve, you can choose the
approach most appropriate for your application, but you must be aware of the conse-
quences. Both cases are illustrated in figure 2.12.

EXAMINING THE PAGE STACK

Let’s examine the two scenarios presented in figure 2.12. In the top sequence the nav-
igation uses GoBack to return to HelloPage, so the page stack is reduced. In the
sequence on the bottom, the navigation uses Navigate to navigate to HelloPage, and
a new page is added on top of the page stack and made visible.

 You should watch out for a couple of gotchas when navigating with the
NavigationService. If you pass in an invalid or misspelled filename to the Navigate
method, or if you forget the leading / character, the NavigationService will raise the
NavigationFailed event. A NavigationFailed event is also raised if you call GoBack
when the NavigationService’s CanGoBack property returns false. By default the
NavigationFailed event is handled in App.xaml.cs in the RootFrame_Navigation-
Failed method generated by the project template.

 Your Hello World application now moves from one page to another, and the Greet-
ing page starts up as expected. How do you get the user-entered name from the Hello
page to the Greeting page? The XAML navigation framework provides features to
enable passing data into a newly launched page.

2.4.2 Passing parameters between pages

In the preceding example you concentrated on navigation between pages but didn’t
pass any information to the Greeting page. In theory, pages should be as self-contained
as possible in order to maintain isolation between the pages, but it can be useful to pass

Hello page Hello page 

Hello page 

Greeting page 

Hello page 

Hello page 

Greeting page Hello page (2) 

Hello page 

Greeting page 

Navigate 
 GreetingPage ( 

 (  ( 
Navigate 

GreetingPage ) 

) 

Navigate 
    HelloPage ) 

GoBack() 

Figure 2.12 The navigation page stack resulting from GoBack (top) and Navigate (bottom) method 
calls—the white boxes represent the visible page, whereas the shaded boxes are the pages in the 
background.
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parameters when navigating. You could choose to use some form of global data or data
cached in the App class instead of passing data, but you should consider passing param-
eters in the Uri much as you would pass data to a constructor. As you’ll learn later in
the chapter, the operating system can call your page directly without ever constructing
an instance of your main page.

 In your sample main page, the user enters a name into a TextBox control named
nameInput whose Text property will be used as a parameter passed to GreetingPage.
GreetingPage will set the text block having the name helloMessage with the parame-
ter passed by HelloPage. Two changes are required in your code to pass a parameter:
HelloPage must pass the parameter value to GreetingPage via the navigation Uri, and
GreetingPage must extract the parameter value from the query string. This process is
shown in figure 2.13.

BUILDING A URI WITH A PARAMETER

When you first added page navigation to the application, you created a URI with the
hardcoded name of the Greeting page in the nameInput_ActionIconTapped method.
You could choose to hardcode the parameters as well, but now you have more magic
strings in your code. What if you change the name of the Greeting page or change the
name of the parameters passed in the query string? You’ll move Uri construction code
into a static method of the GreetingPage class next. Modify the Uri to pass a parame-
ter in the same manner that you would if you were adding fields to a standard HTTP
query string:

public static Uri BuildNavigationUri(string name)
{
    return new Uri("/GreetingPage.xaml?name=" + name, UriKind.Relative);
}

Pass the name as a
query string parameter.

Extract the name and
display on the page.

Figure 2.13 The navigation URI to the GreetingPage includes a query string 
parameter. The parameter is used to pass the name entered in the PhoneTextBox 
from MainPage to GreetingPage. GreetingPage extracts the passed value 
and displays it in a TextBlock. 
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Update the nameInput_ActionIconTapped method in HelloPage.xaml.cs to call the
new factory method, passing along the name entered by the user. The parameter
value is obtained from the nameInput control:

NavigationService.Navigate(
     GreetingPage.BuildNavigationUri(nameInput.Text));

The data passed via the navigation Uri can be retrieved from the target page’s
NavigationContext property. The NavigationContext class has a single property
named QueryString, which is an IDictionary<string, string> mapping parameter
names to values.

 You’ll use the NavigationContext in the code-behind for GreetingPage.xaml. The
appropriate time to access the query string is after the page navigation has completed.
The navigation framework calls the PhoneApplicationPage.OnNavigatedTo virtual
method when navigation is complete. In the sample application, you override
OnNavigatedTo and obtain the parameter value by using the string "name" as a key into
the QueryString. You set the returned value into the Text property of helloMessage: 

protected override void OnNavigatedTo (NavigationEventArgs e)
{
    helloMessage.Text = 
        this.NavigationContext.QueryString ["name"];
}

OnNavigatedTo is one of the virtual methods defined by PhoneApplicationPage that
are called when navigation events occur. OnNavigatedFrom and OnNavigatingFrom are
two other methods you can use to determine when the current page is changing. 

 In this section we’ve shown you how to use code to navigate between the pages of an
application. Other activities, such as the user pressing the hardware Back key, can cause
navigation changes in your application. Every Windows Phone is equipped with a hard-
ware Back key. Its effect in an application is equivalent to calling the Navigation-
Service.GoBack method.

2.4.3 Changing the Back key behavior

When the Back key is pressed, the navigation framework automatically performs a
GoBack operation. The Back key behavior can be interrupted, for example, to avoid
moving off a page that has unsaved changes. To interrupt the automatic GoBack, the
PhoneApplicationPage class provides an event named BackKeyPress. You’ll see this
event in action by wiring it to an event handler in your GreetingPage class. Edit Greet-
ingPage.xaml by adding an attribute to the PhoneApplicationPage tag:

BackKeyPress="Page_BackKeyPress"

Add the event handler to GreetingPage.xaml.cs. This example prompts the user with
a confirmation message:

using System.ComponentModel;
...
void Page_BackKeyPress (object sender, CancelEventArgs e)
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{
    MessageBoxResult result = MessageBox.Show(
        "Press OK to return to the previous page.", 
        "WP8 in Action", MessageBoxButton.OKCancel);
    if (result == MessageBoxResult.Cancel)
        e.Cancel = true;
}

If the user taps the Cancel button in the message box, you set the CancelEvent-
Args.Cancel property to true. This cancels the default behavior of the Back key. Fail-
ing to add this statement or setting e.Cancel to false would have maintained the
default behavior, which is to move to the previous page or terminate the application if
no other pages are in the page stack.

NOTE “App certification requirements for Windows Phone” (http://mng.bz/
Fefo) details appropriate application behavior when working with the Back
key. Specifically, when the Back key is pressed while the main page is visible, the
application must exit.

Navigation relies on URI and query strings to navigate to specific locations within an
application. You can also use navigation strings to allow a user to launch to a specific
location within your application with application tiles.

2.4.4 Navigating with tiles

Chapter 1 introduced you to Live Tiles, the
dynamic images an application can pin to the Start
Screen. Windows Phone users can pin an applica-
tion’s tile to the Start Screen. Applications can also
create secondary tiles that navigate directly using a
deep-link URI or a specific location in an applica-
tion. Figure 2.14 shows the application and sec-
ondary tiles for the Hello World application.

 When the user taps the application tile for
Hello World, the application is launched, and the
NavigationService is called with the URL /Hello-
Page.xaml. When the user taps the secondary tile,
the application is launched and the application
host passes the URL associated with the secondary
tile to the NavigationService. When you built the GreetingPage, you added a pin
button to the application bar. Add a click handler to the pin button and implement
the code in the following listing to create a secondary tile.

private void pinButton_Click(object sender, EventArgs e)
{
   var tileData = new FlipTileData
   {

Listing 2.4 Pinning a secondary tile

Figure 2.14 Application and 
secondary tiles for Hello World
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      SmallBackgroundImage = new 
         Uri("/Assets/Tiles/FlipCycleTileSmall.png", UriKind.Relative),
      BackgroundImage = new 
         Uri("/Assets/Tiles/FlipCycleTileMedium.png", UriKind.Relative),
      WideBackgroundImage = new 
         Uri("/Assets/Tiles/FlipCycleTileLarge.png", UriKind.Relative),
      BackTitle = string.Format("Hello {0}!", helloMessage.Text),
      BackContent = "Windows Phone 8 in Action",
      WideBackContent = "Windows Phone 8 in Action. Written by 
      ➥ Binkley-Jones, Perga, Sync, and Benoit.",
   };
   ShellTile.Create(BuildNavigationUri(helloMessage.Text), tileData, true);
}

The FlipTileData class has several properties that set the image and text shown on
the front side and flip side of the tile. The image properties are set to the Uri contain-
ing the path to three images created in the /Asset/Tiles project folder by Visual Stu-
dio. The Create method of the ShellTile class is used to create the new tile. Specify
the Uri to the Greeting page, passing the same parameters specified by HelloPage.
When ShellTile.Create is called, the application exits, and the Start Screen is
launched, showing the new secondary tile to the user.

The FlipTileData class is one of three different tile data classes that can be used to
pin secondary tiles. The other two are CycleTileData and IconicTileData. These
classes all have different properties that are relevant to the three types of Live Tiles
you learned about in chapter 1.

Tile types and properties

You learned in chapter 1 that tiles are displayed on the Start Screen in one of three
formats: Flip, Iconic, or Cycle. Each of the tile formats can be one-quarter size, normal
size, or double-wide size.

Flip tiles display a title, a count, and a background image on the front of the tile. The
back of a Flip tile displays a message as well as a title and image but doesn’t display
the count. Flip tile properties are specified through the properties of the FlipTileData
class: BackBackgroundImage, BackContent, BackgroundImage, BackTitle,
Count, SmallBackgroundImage, Title, WideBackBackgroundImage, WideBack-
Content, and WideBackgroundImage. 

Iconic tiles have only a single side, which displays a title, icon, and count. Iconic tile
properties are specified through the properties of the IconicTileData class: Back-
groundColor, Count, IconImage, SmallIconImage, Title, WideContent1,
WideContent2, and WideContent3.

Cycle tiles display a title and count and cycle through up to nine different background
images. Cycle tile properties are specified through the properties of the CycleTile-
Data class: Name, Count, CycleImages, SmallBackgroundImage, and Title.
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 In this section you implemented the final requirement for your Hello World appli-
cation—navigating to a second page and displaying a greeting to the user. You learned
about the NavigationService and how to use query string parameters to pass data
between pages. And you learned how to use tiles to navigate directly to the Greeting
page from the Start Screen. 

2.5 Summary
The Windows Phone Developer Tools help you build many different kinds of applica-
tions. Project templates are provided for simple projects and class libraries as well as
list, pivot, panorama, HTML5, and XAML with Direct3D projects. You can read more
about panorama and pivot applications in chapter 14 and HTML5-based applications
in chapter 17. 

 The Windows Phone application framework makes it easy to align your application
with the system theme and style. The framework injects resources into applications so
they can match the system theme (light versus dark, accent color) and the look and
feel (fonts, colors, sizes). The visual designers and property editors in Visual Studio
expose theme resources.

 XAML has been extended for Windows Phone with components built specifically
for the platform. New navigation frame, page control, and application bar compo-
nents are a few of the additions. Other existing controls have been modified to work
on the phone. The chapters in part 3 of this book look at these new and modified
components. 

 System capabilities must be declared in order to use many of the core phone APIs.
The phone APIs provide access to the native applications, services, sensors, and media
features of the phone. In part 2 of this book, you’ll read about how to use the phone
APIs. In the next chapter, you’ll learn how Windows Phone implements application
multitasking and how to design an application to handle lifecycle events. 
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